
W HAT IS E XTENSIS P ORTFOLIO ™?
Portfolio is an electronic media cataloging tool that gives you quick, easy, and efficient ways to organize, browse,
manage, retrieve, and use files containing digital data. 

Portfolio catalogs all types of digital files and images, regardless of the file format, file location, or the applica-
tion used to create the file. Cataloged files can be viewed as thumbnails or by list, and information about the
image file, such as size, type, creation date, location, and other data are available at the click of a button.
Keywords and other search criteria help you quickly locate, access, and reuse your digital files. And handy drag
and drop functions give you easy ways to transfer, copy, or place cataloged images.

HOW CAN P ORTFOLIO HELP ME?
Portfolio makes quick work of finding and retrieving images. 

Use Portfolio to keep visual catalogs of: 
• All the art and photographs used in a newsletter, brochure, manual, or presentation.
• Artwork, pictures, scans, movies, sounds, and even 3D images that you may want to use repeatedly in

different projects, including all your stock and royalty free art on CD-ROM disks. 
• Artwork created by your family for use in greeting cards, letters, and holiday projects.
• Miscellaneous pieces of clip art for quick and convenient reference and use.

Or use catalogs to visually distinguish similar images, such as different sizes, colors, or content of a masthead or
logo, or where filenames alone are not enough to describe images. And it’s really simple to do—simply drag and
drop your files into open Portfolio windows to create, add to, and update catalogs. You can even drag and drop
items right from the catalog into documents that you create in other programs that support this feature, such as
QuarkXPress, PageMaker 6.5, and CorelDraw. And because Portfolio catalogs capture only a thumbnail image
of each cataloged file and not the file itself (keeping instead a “link” to the file’s location), cataloging images
with Portfolio takes up much less space than copying images into a scrapbook.

HOW CAN THIS GUIDE HELP ME?
If you’re new to Portfolio, you can use this guide as a quick way to get “up and running.” But even if you’re an
old hand at creating and using Fetch catalogs, you may find some exciting new features here. When you’ve fin-
ished with this guide, you’ll know enough about Portfolio to create and use simple catalogs, and you’ll be aware
of some of the more commonly used features. To learn more about Portfolio and the many options and features
available, refer to your Extensis Portfolio User Manual and to the ReadMe files in your Portfolio application
folder.
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WE L C O M E TO EX T E N S I S P O RT F O L I O !

B ROWSING CATALOG ITEMS IN THUMBNAILVIEW

B ROWSING CATALOG ITEMS IN L IST VIEW
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B ROWSING CATALOGS

THE S AMPLE CATALOG
A Sample Catalog, located on the Extensis CD inside the Po rtfolio 3.0 folder, includes samples of the many
types images that can be cataloged and viewed (including sounds, movies, and 3D images) with Po rt f o l i o. We
suggest you use this sample catalog to experiment with the different features highlighted in this guide. If yo u
do not have access to the Sample Catalog, or wish to create your own catalog, refer to page 8 “Creating a New
C a t a l o g . ”

OPENING A CATALOG
To open Portfolio, simply double-click on the catalog icon you wish to view, drag a catalog over the Portfolio
icon, or double-click the Portfolio application icon. Note that when you double-click the Portfolio icon,
Portfolio opens whatever catalog you have indicated as the “default” catalog. If no default catalog is indicat-
ed, Portfolio will allow you to either create a new catalog or to locate a catalog to open.



DISPLAYING ALL CATALOG ITEMS
By default when Portfolio has opened your catalog, Portfolio displays all the items in that catalog.  In the
example, notice the name displayed at the top is Portfolio Sample Catalog.fdb.  In the lower left corner of
this window is the number of items contained in this gallery and in the catalog as a whole.  A gallery is any
window containing items from the catalog and it may contain all or any subset of the items in the catalog.

DISPLAYING S ELECTED CATALOG ITEMS
Use the Find window to search for and select particular items of interest. For example, say we’re interested in
finding some pictures for a newsletter we’re writing, and that our newsletter focuses on eating and nutrition.
We know that some of the items in our catalog relate to food, and that when our catalog was created these
items were given appropriate “keywords” so we could find them easily. One of the keywords we created was
“food.”

Using the Find window, we select the appropriate search criteria. In this case we select: Find items whose
Keyword ▼ starts with▼ then enter the word food in the search-word box and click  “Find.”   Note: the
arrow (▼) lets you know that you can “click and hold for more choices.” You can access the Find window at any
time with Cmd-F Mac, Ctrl-F Windows, or by selecting Find from the Catalog menu.

When the search for all items with the keyword “food” is complete, Portfolio displays them in the Gallery
window in whatever view was last used (in this case, Thumbnail View). In our example, Portfolio indicates
(in the lower left corner of the window) that 10 items with the keyword “food” were found.

If our search resulted in too many items, or we didn’t find the item(s) we we re looking for, we could generate a
n ew search. We could try using a different keyword, or use the dro p - d own menus to change search criteria
options, or we could click “Mo re Choices” to add search criteria and narrow the search. T h e re are numero u s
s e a rch options available, including searching by Filename, using AND/OR, using Do e s / Does Not match, etc.
For a more detailed description of the search criteria and choices available, refer to your Extensis Po rtfolio Us e r
Ma n u a l .

UP A N D RU N N I N G
W I T H PO RT F O L I O 3 . 0

S EARCHING CATALOGS



P REVIEWING CATALOG ITEMS
Once you’ve located an item of interest, there are a number of things you can do with it, including looking at a
larger view of it. This larger view is called a “Preview.” To Preview an item, simply double-click its thumbnail.

In our example, we found a picture of vegetables. We double-clicked in the image area of the thumbnail and
Portfolio displayed our picture in a Preview window.

VIEWING ITEM INFORMA TION
Selecting Item Properties from the item menu (Cmd-I Mac, Alt-Enter Windows) displays information about the
currently selected item.  This tabbed dialog displays detailed information about the image, including its file-
name, type, size, creation date, modification date, pathname, keywords, and description and any custom field
information. 

In our example, the item description indicates that this is a stock art image from Image Club Graphics and that
it is available in high resolution TIFF format. Item Properties also shows all keywords assigned to the itemon the
Keywords tab. The number beside each keyword indicates how many items in the catalog have been assigned
that same keyword. Note: Double-clicking on any keyword in the keyword list initiates a search for all items with
that keyword. When the search is complete, the found items are displayed in the Gallery window. 
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DISPLAYING AN ITEM IN L IST V IEW
Although viewing lists of images in Thumbnail View allows you to see many images at a glance, the amount
of information about the item that can be displayed along with the thumbnails is limited. To see more infor-
mation “at a glance,” try List View. To switch to List View select List from the View menu or Cmd-L Mac,
Ctrl-L Windows.

You can also scroll up and down in any of the windows displayed in Gallery List View, and resize the Gallery
window as needed.

WORKING WITH MUL TIPLE CATALOGS
Portfolio allows you to have multiple catalogs open at the same time.  This lets you easily copy items
between catalogs either by drag and drop or using the Clipboard to copy and paste.
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One of the greatest values of a catalog is the ability to search for and see image files without opening the appli-
cation that created them, and be able to instantly copy those images to other documents right from the catalog
list. For example, you might place a photograph modified in Adobe Photoshop into a newsletter created in
QuarkXPress, or you might want to place a movie created in QuickTime into your presentation created in
Adobe Persuasion. 

Portfolio makes the entire process very easy. Once you’ve selected an image, you can copy it to another docu-
ment by dragging (if the application can accept dragged images), or by the standard copy and paste method.
You can copy images from either view of the Gallery window or from the Pasteboard.

COPYING IMAGES —DRA G AND DROP
Some applications, such as PageMaker 6.5 and ClarisWorks, accept images dragged from other applications.
Others, such as QuarkXPress, normally cannot. However, Extensis is developing plug-ins to make this feature
available in other applications. One such plug-in from Extensis, a Quark XTension named “QX–Drag&Drop” is
provided free of charge with Portfolio. This file is placed in the Portfolio Extras folder located in the Portfolio
application folder when Portfolio is installed. To use this Quark XTension, launch the installer and follow the
instructions.  After installation, the drag and drop feature will be activated the next time you launch
QuarkXPress.

To drag and drop an image from a Portfolio catalog into a Quark document, simply open to either Gallery view
(Thumbnail or List Text) or the Pasteboard view (described below), and drag the item into your document. The
necessary picture box will be created and placed inside the Quark document at the location of the cursor.
Portfolio automatically passes link information to Quark about the file’s location (refer to Quark documentation
for more information about linked files). 

COPYING IMAGES —COPY AND PASTE
To copy a cataloged item for pasting in another document, select the item then select “Copy” from the Edit
menu, or press Cmd-C Mac, Ctrl-C Windows. The item will be copied to the standard Clipboard. Note: If the
item to be copied is very large and your RAM memory is limited, you may not be able to copy the item to the clip -
board.

To paste the item in a document, select “Paste” from the Edit menu.
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CREATING NEW CATALOGS
When creating a catalog, first decide what items you’d like to have in your catalog. You can include documents,
pieces of art, photographs, sound files, movies, multi-media files, folders with items and/or other folders in
them—almost any electronic file can be cataloged! Just be aware that everything inside the folders will become a
catalog item. While you can catalog anything almost instantly, to make the best use of a catalog, we suggest that
you do a little planning before you start. 

Create a new catalog by pulling down the File menu and select New.  Name your new catalog; in this example
the new catalog is named My Catalog.fdb.

A DDING ITEMS TO YOUR CATALOG
After you’ve created your catalog, find  items you’d like to add to it. You can quickly and easily add items

to your catalog by dragging them  from a folder window and dropping them into the catalog Gallery window.
When you release your dragged item in a Portfolio window, Portfolio presents the Options tab from the Catalog
Properties dialog. When the update is complete, Portfolio updates the Gallery window to reflect the new item.
In this example we’re cataloging stock photography from Image Farm Inc.  The filenames would not be that
useful in determining the contents of one of these files, but after you’ve cataloged them, you can quickly browse
the thumbnails in the gallery to find the files you need.

UPD ATING ITEMS IN YOUR CATALOG
Remember that Portfolio keeps only  a thumbnail of the image in the catalog, and it looks for the actual file
when displaying the Preview window and when placing (copying) images in other documents.  If you move the
file associated with a catalog image, you’ll need to make Portfolio aware of the move, and allow it to update that
item information in your catalog. If you do not, Portfolio won’t know where to find the image, and you’ll be
limited in what you can do with it—you won’t, for example, be able to copy the image to another document.

The easiest way to update Portfolio after you move a file is to select that file in the Finder or Explorer, then drag
it to the open catalog and select update from the Catalog Options dialog that pops up. This action will update
the link to the original file. 
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CATALOG P ROPERTIES
The Catalog Properties tabbed dialog provides detailed information about the catalog as a whole, such as the: 

• Number of items in the catalog.
• Creation and modification dates.
• File types excluded from that catalog
• Catalog statistics, such as all catalog keywords and number of items containing each keyword

To open Catalog Properties, select “Catalog Properties” from the Catalog menu, or Cmd-J Mac ,Ctrl-J
Windows.

KEYWORDS & M ASTER KEYWORD PALETTE
Keywords are an important key in your ability to search for and find cataloged items. You can add and delete
keywords for all catalog items in Portfolio, and you can extract keywords and descriptions from image source
files when you add them to a catalog (Mac only). You can add sets of keywords to multiple items at the same
time, and you can delete keywords the same way.

T h e re are several ways to add and edit keywords in Po rt f o l i o :
• To edit keywords for a single item, select Item Properties, then click the Keywords tab.
• To edit keywords for multiple items at once, perhaps to delete keywords, select the items you wish to edit key-

words for, then pull down the Item menu and select Edit Keywords.
• To quickly assign keywords to items in the gallery, turn on the Master Keyword Palette by pulling down the

View menu and selecting Master Keyword Palette.

The Master Keyword Palette is a floating palette.  You can assign keywords from the palette to items in the cata-
log by dragging those keywords to those items.  You can also quickly search for items inthe catalog that contain
specific keywors by double-clicking on a keyword in the palette.  In this example we double-clicked on the key-
word People.  To quickly scroll through a long keyword list to the keyword People, type the first few leatter of
People in the text box at the top of the Master Keyword Palette.

For more information on keywords and keywording strategy, refer to your Extensis Portfolio User Manual and
to the “Portfolio Keywording Strategies” file in your Portfolio application folder.
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L AUNCHING OTHER APPLICATIONS
You can launch the application which created (or can read or edit) a cataloged item directly from Portfolio. For
example, you might want to modify photographs using Adobe PhotoShop, or make changes to illustrations
using Adobe Illustrator. Or you might want to view a PDF file in your catalog without leaving Portfolio.
Portfolio utilizes the operating system (Macintosh Easy Open Mac, Registry Windows) to determine which
application to launch for each type of file in your catalog. 

To launch an application: Select the item you wish to edit (or view) then choose “Edit Original” from the Item
menu, or use the keyboard shortcut Cmd-M Mac, Ctrl-M Windows. Portfolio will launch the application you
have chosen, and then open the selected catalog item. If no application has been set for this filetype, a dialog
box will be displayed so that you can select an appropriate application. To specify a different application to use
when selecting Edit Original for any file type,hold down the Option key Mac, Shift key Windows when select-
ing Edit Original.

S HARING CATALOGS WITH OTHER USERS
Portfolio catalogs can be easily shared across a network. Appropriate security features are available to ensure that
only authorized users can add or delete catalog items, make changes to keywords and descriptions, etc. For
detailed information on setting up shared catalogs refer to your Extensis Portfolio User Manual.
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LEARNING MORE ABOUT P ORTFOLIO
We’ve covered a number of Portfolio features in this guide, but the information presented was necessarily limit-
ed. There’s much more information available both on the features presented here, and on the many helpful fea-
tures and options that we didn’t mention. We invite you to take advantage of the following additional informa-
tion sources covering Extensis Portfolio:

• Extensis Portfolio 3.0 User Manual
• Portfolio Keywording Strategies—an Acrobat PDF file located in your Portfolio Extras folder
• Help—available from the menu bar
• ReadMe—a text file located in your Portfolio application folder with late-breaking information
• Sample Catalog—a catalog of images for you to play and practice with, located in the Portfolio folder on the

Extensis CD

ADDITIONAL P ORTFOLIO P RODUCTS
For information on creating and publishing CD catalogs using the Extensis Content Publisher’s Toolkit and
Portfolio Browser, or for site license information, contact us at 800-796-9798, and ask for Corporate Sales. Or
send E-mail to sales@extensis.com

OTHER P RODUCTS F ROM E XTENSIS
In addition to Extensis Portfolio, Extensis offers an array of application-specific products that extend the capa-
bilities of popular graphics and layout applications. Extending the capabilities of such award-winning programs
as QuarkXPress, Adobe Photoshop, Adobe Illustrator, Adobe PageMaker, and Macromedia FreeHand enables
advertising and design professionals, production artists, and desktop publishers, as well as multimedia develop-
ers, graphic, game, world wide web designers, digital imagers, and photographers to maximize their investment
in their graphics application software.

A bro c h u re (in Adobe Ac robat PDF format) for each Extensis product is available for viewing in the Sa m p l e
Catalog, located in the Po rtfolio folder on the Extensis CD. To locate product bro c h u res use the keyword
“ Extensis.” 

To view an Extensis product brochure: Select the brochure you wish to view, then choose “Edit Original” from
the Item menu, or use the keyboard shortcut CMD+G. Portfolio will launch Adobe Acrobat and open the
brochure. 
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FO R MO R E IN F O R M A T I O N

E XTENSIS CORPORATION
1800 S.W. First Avenue, Suite 500
Portland, OR 97201
Phone: 503-274-2020
Fax: 503-274-0530
E-mail: info@extensis.com
Internet: http://www.extensis.com

CUSTOMER S ERVICE
Phone: 800-796-9798
E-mail: sales@extensis.com

TECHNICAL S UPPOR T
Phone: 503-274-7030

Monday–Friday, 8am–5pm Pacific
E-mail: support@extensis.com


